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Preface
Welcome to the Composer Voice 8.0.1 Deployment Guide. This document 
explains how to install and configure Composer Voice. For an introduction to, 
and details about the component features, see the Composer Voice 8.0.1 Help 
file that is included with the software.
This document is valid only for the 8.0.1 release of this product.

Note: For releases of this document that have been created for other releases 
of this product, please visit the Genesys Technical Support website, or 
request the Documentation Library CD, which you can order by e-mail 
from Genesys Order Management at orderman@genesyslab.com.

This preface provides an overview of this document, identifies the primary 
audience, introduces document conventions, and lists related reference 
information: It contains the following sections:

Intended Audience, page 7
Chapter Summaries, page 8
Document Conventions, page 8
Related Resources, page 10
Making Comments on This Document, page 12
Document Change History, page 13

Composer Voice is a graphical user interface (GUI) for the development of 
voice applications that use Voice Extensible Markup Language (VoiceXML).

Intended Audience
This document is intended primarily for system integrators and administrators 
and assumes that you have a basic understanding of:
• Computer-telephony integration (CTI) concepts, processes, terminology, 

and applications.
• Network design and operation.
• Your own network configurations.
You should be familiar also with the Genesys Framework architecture.

mailto:orderman@genesyslab.com
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In order to use the Composer Voice software successfully, you should be 
familiar with Hypertext Markup Language (HTML), Extensible Markup 
Language (XML), and VoiceXML concepts

Chapter Summaries
In addition to this preface, this document contains the following chapters:
• Chapter 1, “Installation and Troubleshooting,” on page 15, provides the 

operating requirements and installation instructions for Composer Voice, 
plus relevant troubleshooting issues.

• Chapter 2, “Uninstallation,” on page 33, provides uninstallation 
instructions for Composer Voice.

Document Conventions
This document uses some stylistic and typographical conventions—introduced 
here—that serve as shorthand for particular kinds of information.

Document Version Number

A version number appears at the bottom of the inside front cover of this 
document. Version numbers change as new information is added to this 
document. Here is a sample version number:
80cv_dep_01-2009_v8.0.101.00 

You will need this number when you are talking with Genesys Technical 
Support about this product.

Type Styles

Italic

In this document, italic is used for emphasis, titles of documents, definitions of 
(or first references to) unfamiliar terms, and mathematical variables.

Examples: • Do not use this value for this option.
• Please consult the Genesys 7 Migration Guide for more information.
• A customary and usual practice is one that is widely accepted and used 

within a particular industry or profession.
• The formula, x +1 = 7 where x stands for . . .
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Monospace Font

A monospace font, which looks like teletype or typewriter text, is used for 
all programming identifiers and GUI elements. 
This convention includes the names of directories, files, folders, configuration 
objects, paths, scripts, dialog boxes, options, fields, text boxes, list boxes, 
operational modes, all buttons (including radio buttons), check boxes, 
commands, tabs, CTI events, and error messages; the values of options; logical 
arguments and command syntax; and code samples.

Examples: • Select the Show variables on screen check box.
• Click the Summation button.
• In the Properties dialog box, enter the value for the host server in your 

environment.
• In the Operand text box, enter your formula.
• Click OK to exit the Properties dialog box.
• The following table presents the complete set of error messages that 

T-Server distributes in EventError events.
• If you select true for the inbound-bsns-calls option, all established 

inbound calls on a local agent are considered business calls.
A monospace is used also for any text that users must enter manually during a 
configuration or installation procedure, or on a command line:

Example: • Enter exit on the command line.

Screen Captures Used in This Document

Screen captures that are taken from the product GUI, as used in this document, 
sometimes might contain a minor spelling, capitalization, or grammatical error. 
The text that accompanies and explains the screen captures corrects such errors 
except when such a correction would prevent you from installing, configuring, 
or successfully using the product. For example, if the name of an option 
contains a usage error, the name would be presented exactly as it appears in the 
product GUI; the error would not be corrected in any accompanying text.

Square Brackets

Square brackets indicate that a particular parameter or value is optional within 
a logical argument, a command, or some programming syntax. That is, the 
presence of the parameter or value is not required to resolve the argument, 
command, or block of code. The user decides whether or not to include this 
optional information. Here is a sample:
smcp_server -host [/flags]s
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Angle Brackets

Angle brackets indicate a placeholder for a value that the user must specify. 
This might be a DN or port number that is specific to your enterprise. Here is a 
sample:
smcp_server -host <confighost>

Related Resources
The following resources provide additional information that is relevant to this 
software. Consult these additional resources as necessary.

Composer Voice

• Composer Voice 8.0.1 Help, which provides integrated help information 
about using Composer Voice, a GUI for the development of applications 
based on VoiceXML and Call Control XML (CCXML).

Management Framework

• Framework 8.0 Deployment Guide, which provides information about 
configuring, installing, starting, and stopping Framework components.

• Framework 8.0 Genesys Administrator Help, which provides information 
about configuring and provisioning contact center objects by using the 
Genesys Administrator.

• Framework 8.0 Configuration Options Reference Manual, which provides 
descriptions of the configuration options for Framework components.

SIP Server

• Framework 7.6 SIP Server Deployment Guide, which provides information 
about configuring and installing SIP Server.

Genesys Voice Platform

• Genesys Voice Platform 8.1 Deployment Guide, which provides 
information about installing and configuring Genesys Voice Platform 
(GVP).

• Genesys Voice Platform 8.1 User’s Guide, which provides information 
about configuring, provisioning, and monitoring GVP and its components.
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• Genesys Voice Platform 8.1 Genesys VoiceXML 2.1 Reference Help, which 
provides information about developing Voice Extensible Markup 
Language (VoiceXML) applications. It presents VoiceXML concepts, and 
provides examples that focus on the GVP Next Generation Interpreter 
(NGI) implementation of VoiceXML.

• Genesys Voice Platform 8.1 Legacy Genesys VoiceXML 2.1 Reference 
Manual, which describes the VoiceXML 2.1 language as implemented by 
the Legacy GVP Interpreter (GVPi) in GVP 7.6 and earlier, and which is 
now supported in the GVP 8.1 release.

• Genesys Voice Platform 8.1 CCXML Reference Manual, which provides 
information about developing Call Control Extensible Markup Language 
(CCXML) applications for GVP.

• Genesys Voice Platform 8.1 Troubleshooting Guide, which provides 
information about Simple Network Management Protocol (SNMP) 
Management Information Bases (MIBs) and traps for GVP, as well as 
troubleshooting methodology.

• Genesys Voice Platform 8.1 Configuration Options Reference, which 
replicates the metadata available in the Genesys provisioning GUI, to 
provide information about all the GVP configuration options, including 
descriptions, syntax, valid values, and default values.

• Genesys Voice Platform 8.1 Metrics Reference, which provides 
information about all the GVP metrics (VoiceXML and CCXML 
application event logs), including descriptions, format, logging level, 
source component, and metric ID.

Voice Platform Solution

• Voice Platform Solution 8.1 Integration Guide, which provides 
information about integrating GVP 8.1, SIP Server 7.6, and, if applicable, 
IVR Server.

Open Standards

• W3C Voice Extensible Markup Language (VoiceXML) 2.1, W3C 
Recommendation 19 June 2007, which is the World Wide Web 
Consortium (W3C) VoiceXML specification that GVP NGI supports.

• W3C Voice Extensible Markup Language (VoiceXML) 2.0, W3C 
Recommendation 16 March 2004, which is the W3C VoiceXML 
specification that GVP supports.

• W3C Speech Synthesis Markup Language (SSML) Version 1.0, 
Recommendation 7 September 2004, which is the W3C SSML 
specification that GVP supports.
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• W3C Voice Browser Call Control: CCXML Version 1.0, W3C Working 
Draft 29 June 2005, which is the W3C CCXML specification that GVP 
supports.

• W3C Semantic Interpretation for Speech Recognition (SISR) Version 1.0, 
W3C Recommendation 5 April 2007, which is the W3C SISR specification 
that GVP supports.

• W3C Speech Recognition Grammar Specification (SRGS) Version 1.0, 
W3C Recommendation 16 March 2004, which is the W3C SRGS 
specification that GVP supports.

Genesys

• Genesys Technical Publications Glossary, which ships on the Genesys 
Documentation Library DVD and which provides a comprehensive list of 
the Genesys and CTI terminology and acronyms used in this document.

• Genesys Migration Guide, which ships on the Genesys Documentation 
Library DVD, and which provides documented migration strategies for 
Genesys product releases. Contact Genesys Technical Support for more 
information.

• Release Notes and Product Advisories for this product, which are available 
on the Genesys Technical Support website at 
http://genesyslab.com/support.

Information about supported operating systems and third-party software is 
available on the Genesys Technical Support website in the following 
documents: 
• Genesys Supported Operating Environment Reference Manual
• Genesys Supported Media Interfaces Reference Manual
Genesys product documentation is available on the:
• Genesys Technical Support website at http://genesyslab.com/support.
• Genesys Documentation Library DVD, which you can order by e-mail 

from Genesys Order Management at orderman@genesyslab.com.

Making Comments on This Document
If you especially like or dislike anything about this document, please feel free 
to e-mail your comments to Techpubs.webadmin@genesyslab.com. 
You can comment on what you regard as specific errors or omissions, as well 
as on the accuracy, organization, subject matter, or completeness of this 
document. Please limit your comments to the information that is in this 
document only and to the way in which the information is presented. Speak to 
Genesys Technical Support if you have suggestions about the product itself.

mailto:techpubs.webadmin@genesyslab.com
http://genesyslab.com/support
http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
http://genesyslab.com/support/dl/retrieve/default.asp?item=A9CB309AF4DEB8127C5640A3C32445A7&view=item
http://genesyslab.com/support
mailto:orderman@genesyslab.com
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When you send us comments, you grant Genesys a nonexclusive right to use or 
distribute your comments in any way that we believe appropriate, without 
incurring any obligation to you.

Document Change History
This section lists topics that are new in the current release of this document, or 
that have changed significantly from the preceding release.

New in Version 8.0.1
The following topics have been added or significantly changed since the initial 
8.0 release of this document:
• “Operating Systems Supported” on page 15

Support for Red Hat Enterprise Linux Advanced Server 4.0 or later 
(32-bit) (for Tomcat 6.0)

• “Genesys Platforms Supported” on page 16
Support for Genesys Voice Platform (GVP) 8.1

• “Application Servers Supported” on page 16
Support for Microsoft Internet Information Services (IIS) 5.1, 6.0, 7.0
Support for Jboss 4.2.3
Support for IBM WebSphere Application Server 6.1

• “Web Browsers Supported” on page 17
Support for Mozilla Firefox 3.0

• “Database Servers Supported” on page 17
Support for Microsoft SQL Server 2005
Support for Oracle 10g Release 2

• “Third-Party Software Requirements” on page 18
Requirement for Microsoft .NET Framework 2.0 and 3.5
Deployment computer operating system and production server options

• “Configure Tomcat Settings” on page 20
Preferences figure showing Tomcat settings

• “Configure IIS Settings” on page 21
Instructions for configuring IIS settings and Preferences figure

• “Configure the Debugger” on page 24
Preferences figure showing debugger settings

• “Firewall Considerations” on page 26
Reference to IIS port
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• “Add MIME Types” on page 28
Instructions for manually configuring MIME types for the Microsoft 
IIS web server

• “Deployment Failure on IIS” on page 30
Instructions for handling this troubleshooting scenario

• “Test Calls Are Not Working” on page 31
Updates to the troubleshooting scenario to handle IIS considerations

For descriptions of all other new features in Composer Voice 8.0.1, please 
refer to the Composer Voice 8.0.1 Help which you can access from the Help 
menu inside Composer Voice.
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Chapter

1 Installation and 
Troubleshooting
This chapter describes the software requirements and installation process for 
Composer Voice 8.0.1. It contains the following sections:

Software Requirements, page 15
Installing Composer Voice, page 18
Post-Installation Configuration, page 20
Troubleshooting, page 29

Software Requirements
Before you install Composer Voice 8.0.1, you must consider all of the 
environment variables that are needed for a successful deployment.

Operating Systems Supported
Each workstation that you use to develop voice applications with Composer 
Voice 8.0.1 must meet one of the following operating system requirements:
• Microsoft Windows Server 2003 with Service Pack 1 or later
• Microsoft Windows XP with Service Pack 2 or later
• Microsoft Windows Vista

• Red Hat Enterprise Linux Advanced Server 4.0 or later (32-bit) (for 
Tomcat 6.0)

Note: GVP 8.1 and the Composer Voice Debugger interface both use Internet 
Protocol version 4 (IPv4). If you are deploying Composer Voice on 
Windows Vista, make sure that you have IPv4 enabled for the network 
interfaces. 
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Genesys Platforms Supported
Composer Voice 8.0.1 supports the following Genesys platform:
• GVP 8.1

Note: Composer Voice 8.0.1 is not backward compatible with GVP 8.0 or 
GVP 7.6 or earlier Genesys platforms.

Speech Engines Supported
Composer Voice 8.0.1 supports all Automatic Speech Recognition (ASR) and 
Text-to-Speech (TTS) engines that GVP 8.1 supports.

SIP Phones Supported
Composer Voice 8.0.1 supports the following SIP phones:
• X-Lite 3.0 (recommended if you are connecting over a virtual private 

network)
• Pingtel 2.4.3
• SJphone version 1.65 or later
• Express Talk 3.08 (recommended if you are using it on a Microsoft 

Remote Desktop connection)

Application Servers Supported
Composer Voice 8.0.1 supports the following web application servers for Java 
Server Page (JSP) applications:
• Apache Tomcat 6.0 for Windows (built into the installation package for 

testing purposes)

Note: Composer Voice installs an embedded Tomcat 6.0 web server for your 
use (code generation and testing). Genesys does not recommend that 
you use this bundled Tomcat web server for deploying and running 
your Composer Voice–generated applications as part of a production 
setup. You may use a separate instance of Tomcat 6.0 as a stand-alone 
web server, depending upon your needs and the recommendations of 
your IT department.

• Apache Tomcat 6.0 for Linux
• Jboss 4.2.3
• IBM WebSphere 6.1
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Composer Voice 8.0.1 supports the following web application servers for 
Active Server Page (ASP) applications:
• Microsoft Internet Information Services (IIS) 5.1, 6.0, 7.0

Web Browsers Supported
Composer Voice 8.0.1 supports the following web browsers:
• Microsoft Internet Explorer 6.0 Service Pack 1 or later
• Microsoft Internet Explorer 7.0
• Mozilla Firefox 2.0, 3.0

Database Servers Supported
Composer Voice 8.0.1 supports the following database servers:
• Microsoft SQL Server 2005

Configure for SQLServer authentication. Composer Voice does not support 
integrated Windows authentication. No other special software needs to be 
installed on the database server.

• Oracle 10g Release 2
Before you can use database blocks in a .NET Voice Project, you need to 
install and configure the Oracle client on the Composer Voice machine. 
Oracle client will be required on any deployment machines as well where 
this application will run. At design time, both Java Voice Projects and 
.NET Voice Projects use bundled JDBC drivers to connect to Oracle, 
which is why your query will work in the Query Builder. At runtime, Java 
Voice Projects continue to use JDBC, while .NET Voice Projects use 
Microsoft's OLEDB providers from .NET Framework. These providers 
need Oracle client to be installed and configured. As a test, after installing 
the client software you should be able to connect to the Oracle database 
from SQLPlus. Once that works, database blocks in your .NET Voice 
Project should also be able to connect to your Oracle database. For 
configuring Oracle client, please contact your Oracle database 
administrator.
Download and install Oracle Database 10g Client Release 2 
(10.2.0.1.0) from:
http://www.oracle.com/technology/software/products/database/oracle1
0g/htdocs/10201winsoft.html

Note: Oracle may change this URL at any time.

http://www.oracle.com/technology/software/products/database/oracle10g/htdocs/10201winsoft.html
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Third-Party Software Requirements
Composer Voice 8.0.1 requires the following third-party software on the 
computer on which Composer Voice is installed:
• Microsoft .NET Framework 2.0 and 3.5 (both are required)
In addition, the computer on which you will deploy voice applications created 
by Composer Voice can have one of the following configurations:
• Windows + IIS
• Windows + Tomcat
• Windows + Jboss
• Windows + IBM WebSphere
• Red Hat Linux + Tomcat

Installing Composer Voice
Before you install Composer Voice 8.0.1, make sure that:
• You have an account that has administrative privileges to install Composer 

Voice.
• You have installed a supported SIP phone on your desktop (required if you 

want to conduct test calls).
• You have installed Microsoft .NET Framework 2.0 and .NET Framework 

3.5, for ASP.NET support in Composer Voice.

Note: Genesys does not recommend installation of its components through a 
Microsoft Remote Desktop connection. You should perform the 
installation locally.

Procedure:
Installing Composer Voice

Start of procedure

1. Insert the Composer Voice 8.0.1 CD into the computer on which you want 
to install Composer Voice. 
Auto-run starts, and the Genesys Installation Wizard’s Welcome screen 
appears.

2. Click Next. 
The Choose Destination Location screen appears.
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3. Accept the default installation path in the Destination Folder text box, or 
click Browse and select an alternate destination. Click Next. 

Note: If you have voice projects from an earlier version of Composer 
Voice and you choose the default folder location in this step, you 
still can access those projects by switching workspaces at any time, 
or by importing the earlier projects to your new workspace. 
Review the Composer Voice Integrated Help System inside 
Composer Voice for details.

The Composer Voice Parameters screen appears.
4. In the Port text box, enter the port that will be used to handle Tomcat (for 

example: 8080). Click Next.
The Ready to Install screen appears.

5. Click Install.
The Installation Status screen appears, and then, after all of the files are 
copied, the Installation Complete screen appears.

6. Click Finish.

End of procedure

Procedure:
Launching Composer Voice

Start of procedure

1. From the Windows Start menu, select Programs > Genesys Solutions > 
GVP > Composer Voice 8.0.1 > Start Composer Voice.

The Workspace Launcher opens to allow you to select the location of your 
workspace.

2. Accept the default entry, or click Browse to navigate to a location that will 
serve as your workspace folder.

Note: For Windows Vista, please be sure that your workspace folders 
will be outside of the Program Files folder.

3. If you want your selected workspace to be your default and do not want to 
select a location the next time that Composer Voice opens, select the Use 
this as the default and do not ask again check box.
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4. Click OK to proceed.
Composer Voice opens.

End of procedure

Post-Installation Configuration
After you have installed Composer Voice 8.0.1, configure Tomcat (and/or 
Microsoft IIS) settings, and the Compose Voice Debugger on your computer, 
as described in this section.
Launch Composer Voice (see Launching Composer Voice, page 19), then 
perform the steps that follow.

Configure Tomcat Settings
Before you can start to create a Java Voice Project that you will deploy later on 
a Tomcat application server, you must configure Tomcat settings for Composer 
Voice as shown in Figure 1. 

Figure 1: Tomcat Preferences
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Procedure:
Configuring Tomcat settings

Start of procedure

1. In Composer Voice, select Preferences from the Window menu.
The Preferences window opens.

2. In the left panel, expand the Composer Voice node and select Tomcat.
3. In the Login field, enter the default login: admin.
4. In the Password field, enter the default password: admin.
5. Click Apply and continue to the procedure: Configuring the debugger, or 

continue to the next procedure Configuring IIS settings if you will also be 
deploying on a Microsoft IIS application server.

End of procedure

Configure IIS Settings
Before you can start to create a .NET Voice Project that you will deploy later 
on a Microsoft IIS application server, you must do the following:
• Allow the ASP.NET web service extension in Internet Information 

Services (IIS) Manager
• Configure IIS settings for Composer Voice
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Figure 2: Allow ASP.NET Web Service Extensions in IIS Manager

Procedure:
Allowing ASP.NET Web Service Extensions in IIS

Start of procedure

1. Open Microsoft Internet Information Services (IIS) Manager on your 
computer.
The Internet Information Services (IIS) Manager window opens as 
shown in Figure 2.

2. In the left panel, expand the Web Service Extensions folder.
3. In the right panel, select the ASP.NET entry.
4. Click Allow.
5. Exit Microsoft Internet Information Services (IIS) Manager.

End of procedure
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Next Steps

• Configure IIS settings for Composer Voice as shown in Figure 3

Figure 3: IIS Preferences

Procedure:
Configuring IIS settings

Start of procedure

1. In Composer Voice, select Preferences from the Window menu.
The Preferences window opens.

2. In the left panel, expand the Composer Voice node and select .NET.
3. In the Website Port (IIS) field, specify the port number of the website on 

IIS on which you want to deploy your voice projects. Typically, this value 
would be 80, which is the port for the Default Web Site in IIS.

4. In the Microsoft .NET Installed Path (aspnet_compiler.exe) field, enter 
the location in which you installed .NET Framework that contains the 
ASP.NET compiler. Typically, this value is the following:
C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_compiler.exe
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5. Click Apply.

End of procedure

Next Steps

• Add Multipurpose Internet Mail Extensions (MIME) types in IIS. Refer to 
the procedure: Adding MIME Types in IIS, page 29.

Configure the Debugger
In order to make test calls, you must perform the debugger configuration as 
shown in Figure 4. 

Figure 4: VXML Debugger Preferences
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Procedure:
Configuring the debugger

Start of procedure

1. Select Preferences from the Window menu, if the Preferences window is 
not currently open.

2. In the left panel, expand the Composer Voice node, and select VXML 
Debugger.

3. Select or enter the IP address of your computer.
4. You will need a SIP phone to make test calls. Specify the default values of 

the SIP Phone User Name, SIP Phone Hostname/IP address of the computer 
on which the SIP phone is running, and the SIP Phone Port. Typically, SIP 
phones run on port 5060 or 5070. Check the settings on your SIP phone, 
and provide the correct information.
If your SIP phone is not running on a dedicated port, please reconfigure it 
so that it can accept calls from the Composer Voice Debugger. For the X-
Lite SIP phone, you can perform the following steps to verify and carry out 
this change:
To verify the X-Lite “SIP Account settings,” select the default entry and 
click the Properties button. In the Topology settings:
a. Right-click in the display screen and select SIP ACCOUNT SETTINGS. 
b. Double-click the username and select the Manually specify range 

check box.
c. Provide the port range as 5060 to 5061 or something similar.
d. Click OK, and restart X-Lite after you make these changes.

5. Set the Platform IP address and Platform Port for the GVP Server.
Typically, the Platform Port will be the default port 5060, or the port that 
you configured for the Resource Manager (RM), or the default port 5070, 
or the port that you configured for the Media Control Platform (MCP) on 
your GVP Server. You can make direct calls to MCP from the debugger. 
However, if you are using preprovisioned DNIS, you will have to make 
test calls to the RM.

6. Click Apply and then click Yes in the Propagate Changes dialog box.
7. Continue to the next procedure: Enabling debugging in the MCP.

End of procedure
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Enable Debugging in the Media Control Platform (MCP)
To use the debugging feature of Composer Voice, the Media Control Platform 
(MCP) must be configured to enable debugging.

Procedure:
Enabling debugging in the MCP

Start of procedure

1. Open Genesys Administrator, connecting to the Management Framework 
that is serving the MCP platform.

2. Under the Provisioning tab, select Environment > Applications and open 
the Application object that corresponds to the MCP.

3. Under the Settings tab, double-click MCP, and in the Options tab, open the 
section that is called vxmli.

4. Change the value of debug.enabled to true.
5. Restart the MCP application.
6. Log out from Genesys Administrator.

End of procedure

Firewall Considerations

TCP Ports

Procedure:
Ensuring TCP ports have been opened

Purpose:  To develop and test Composer Voice applications.

Start of procedure

1. If you have a local firewall on the development server (for example, 
Windows Firewall on Windows XP/Windows Server 2003), make sure that 
the following TCP ports have been opened:
• Tomcat port (generally, this is set to port 8080). If you installed 

Tomcat on a different port, open its corresponding port in the firewall.
• IIS port (generally, this is set to port 80). If you installed IIS on a 

different port, open its corresponding port in the firewall.
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• The UDP port on which your SIP phone is running (by default, this 
will be either 5060 or 5070). Check your SIP phone settings for the 
exact port number.

• RTP ports on which your SIP phone will get the audio stream. Check 
your SIP phone Help file for details on this. Some SIP phones will 
autoconfigure this during installation.

End of procedure

Next Steps

• If you continue to run into problems with the firewall and calls are not 
successful, try turning off the firewall temporarily when you make the test 
calls.

Proxy Settings—Local Proxy

Procedure:
Configuring proxy settings for a local proxy
If you have a local proxy on your network, you will have to configure the 
proxy settings to get the parsing of the Web Services Description Language 
(WSDL) in the Web Service block.

Note: Configure proxy settings only if you are accessing a URL that is 
outside of your network, and you are using a Web Service or Web 
Request block.

Start of procedure

1. Inside Composer Voice, configure proxy settings by going to the 
Preferences page: Window > Preferences > General > Network 
Connections. If necessary, provide the proxy authentication details:
a. Select Manual proxy configuration and provide the HTTP proxy and 

Port.
b. Provide the User Name and Password for authentication.

End of procedure

Next Steps

• You must also configure proxy settings for the bundled Tomcat 6.0 web 
server. See the procedure Configuring proxy settings in Tomcat 6.0.



28 Composer Voice 8.0.1

Chapter 1: Installation and Troubleshooting Post-Installation Configuration

Proxy Settings—Tomcat 6.0

Procedure:
Configuring proxy settings in Tomcat 6.0
Proxy settings have to be configured in the bundled Tomcat 6.0 web server for 
the back-end pages to access the Web when you use Web Request and Web 
Service blocks. 

Start of procedure

1. To configure proxy settings in the bundled Tomcat 6.0 web server, add the 
following lines to the catalina.properties file that is found within the 
..\tomcat\conf folder in the Composer Voice installation path1:
http.proxyHost=hostip

http.proxyPort=port of Proxy

http.proxyUser=username 

http.proxyPassword=password

Note: The username and password must be the same as what was provided 
in the manual proxy configuration.

2. Restart the Composer Voice 8.0.1 Tomcat service: CV801Tomcat.

End of procedure

Add MIME Types
Multipurpose Internet Mail Extensions (MIME) settings already are 
preconfigured in the Tomcat 6.0 web server that is bundled with Composer 
Voice.
MIME Types must be added manually for the Microsoft IIS web server.

1.For an installation of Genesys Composer Voice 8.0.1 using the default installation
path, this file is located in: C:\Program Files\GCTI\gvp\Composer Voice 8.0.1\tom-
cat\conf\.
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Procedure:
Adding MIME Types in IIS

Start of procedure

1. Open Internet Information Services (IIS) Manager on your computer.
2. Right-click your web site (such as Default Web Site), and select 

Properties.
3. Click the HTTP Headers tab.
4. Click the MIME Types button to display the MIME Types dialog box.
5. Add the following MIME types for IIS 6.0 or 7.0:

• vox = application/octet-stream
• vxml = text/xml
• grxml = application/srgs+xml
• wav = application/octet-stream

6. Make sure that ASP.NET extensions are enabled in your IIS. Refer to 
Allowing ASP.NET Web Service Extensions in IIS.

7. Make sure that ASP.NET is enabled on your virtual directory and set to the 
correct version.

8. Make sure that scripts have execute permissions on your virtual 
directory.

End of procedure

Troubleshooting
This section covers some common issues that might occur upon deployment of 
Composer Voice after installation and post-installation configuration.

Note: For troubleshooting issues that apply to GVP 8.1 as a whole, please 
refer to the Genesys Voice Platform 8.1 Troubleshooting Guide.

Tomcat Service Failed to Start
If you receive a message that indicates that the Tomcat service failed to start, 
please carry out the following procedure.
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Procedure:
Correcting a “Tomcat Service Failed to Start” error
Composer Voice bundles Tomcat 6.0 and deploys it as a Windows service that 
is called CV801Tomcat.

Start of procedure

1. From Control Panel > Administrative Tools > Services, check to see if 
the CV801Tomcat service is started.

2. If the service is not started, open the log files in 
${CVInstallPath}/tomcat/logs, and look for an error that resembles the 
following: java.net.BindException: Address already in use: JVM_Bind.

3. If you see this error, it means that the port specified in the Tomcat 
configuration screen in the Installation Wizard already is in use. Uninstall 
Composer Voice, and reinstall it using a different value for the port.

End of procedure

Deployment Failure on IIS
In the .NET Voice Project Settings, if you try to deploy the .NET Voice Project 
and it fails each time, check the following:

Procedure:
Correcting a “Deployment Failure on IIS” error

Start of procedure

1. Make sure the post-installation configuration steps have been 
accomplished. Verify the IIS Website port.

2. For Windows Vista, try again after disabling the User Account Control 
(UAC).

3. Make sure IIS is installed and running on the machine that is running 
Composer Voice.

4. Make sure IIS does not have any existing Virtual directory of the .NET 
Voice Project name in the Website where you want to deploy to.

End of procedure
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Test Calls Are Not Working
If the test calls from Composer Voice keep failing, please carry out the 
following procedure.

Procedure:
Correcting a “Received 200 OK Without Receiving 
Debugging Control Info” error
Do you keep getting a Received 200 OK without receiving debugging control 
info error for every test call that is made from Composer Voice?

Start of procedure

1. Make sure that the vxmli.debug.enabled parameter on the MCP is set to 
true. Follow the instructions in “Enable Debugging in the Media Control 
Platform (MCP)” on page 26 to verify the value.

2. Is the Tomcat service or IIS service running?
• If you are using Tomcat, take the actions that are described in “Tomcat 

Service Failed to Start” on page 29. If no port conflict exists, try 
restarting Tomcat from Windows services.

• If you are using IIS, take the actions that are described in “Deployment 
Failure on IIS” on page 30. Try restarting IIS from Windows services.

3. Has configuration been set for Tomcat, (or IIS), and the Composer Voice 
Debugger?
• Check the instructions in the “Post-Installation Configuration” section.

4. Is a SIP phone running on the configured host and port number?
• Check your installation for a SIP phone, and check the SIP phone 

values in the “Post-Installation Configuration” section.
5. Can you make a test call directly from the SIP phone?

• If so, this confirms that the MCP and SIP phone are working fine.
6. Is your SIP phone running on a dedicated port?

• If not, check your SIP phone documentation to see how to configure it 
to run on a dedicated port. If the SIP Phone does not support this, 
switch to one of the SIP phones (such as X-Lite), that provides this 
capability. For X-Lite, refer to Step 4 in Configuring the debugger.

7. Is the Java Voice Project or .NET Voice Project properly deployed?
• For a Java Voice Project (or .NET Voice Project), right-click the 

project name, select Properties, then select Tomcat Deployment (or IIS 
Deployment) and click the Deploy button if necessary.

End of procedure
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2 Uninstallation
This chapter describes the uninstallation process for Composer Voice 8.0.1. It 
contains the following section:

Uninstalling Composer Voice, page 33

Uninstalling Composer Voice

Procedure:
Uninstalling Composer Voice

Start of procedure

1. Go to Control Panel > Add/Remove Programs.
2. Select Genesys Composer Voice 8.0.1 (or a different entry if you are 

uninstalling an earlier release of Composer Voice) from the list of 
currently installed programs, and then click Remove.
The Genesys Installation Wizard’s Welcome screen appears.

3. Select Remove, and then click Next.
A dialog box appears that asks whether you are sure that you want to 
uninstall Composer Voice.

4. Click Yes.
The Installation Status screen appears, followed by the Maintenance 
Complete screen.
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5. Select either Automatically restart the computer now; or I will restart 
the computer later, and then click Finish.

Note: If you choose to restart later, you should do so as soon as possible. 
The machine must be restarted before attempting to install 
Composer Voice again.

End of procedure
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